Geographic information systems (GISs) offer a useful tool for educators to teach students about local and global communities in various subjects. GISs are increasingly being used in K-12 education, but that growth is hindered due to many teachers’ limited access to time or resources necessary to adequately learn a GIS software package such as ArcView. While many of the GIS datasets being used in schools are of global communities, experience shows that students are more motivated to learn when the data pertain to their local community. This paper offers one approach for teachers to more easily incorporate a GIS and community mapping into secondary science curriculum with minimal training through the use of a web GIS.

Arc Internet Map Server (ArcIMS) was used to create the Tahoma Virtual Atlas, a physical geographic atlas covering King and Pierce Counties in Washington. Working with secondary science educators in the Tahoma School District to determine needs, data was compiled from various organizations in the
Seattle/Tacoma area and published in an ArcIMS web site. One designated teacher will take on the maintenance of the site, which can be used from almost any Internet-accessible computer. The atlas will serve as a base that teachers and students will be able to build upon by acquiring or creating other datasets. By combining the Tahoma Virtual Atlas with science curriculum and hands-on fieldwork, students can learn about geographic and scientific issues in their community and in turn utilize that knowledge to better understand global issues.
Integrating Geographic Information Systems
and Community Mapping
into Secondary Science Education:
A Web GIS Approach

by
Elizabeth K. O’Dea

A THESIS
submitted to
Oregon State University

in partial fulfillment of
the requirements for the
degree of

Master of Science

Presented June 10, 2002
Commencement June 2003

APPROVED:

Major Professor, representing Geography

Chair of the Department of Geosciences

Dean of the Graduate School

I understand that my thesis will become part of the permanent collection of Oregon State University libraries. My signature below authorizes release of my thesis to any reader upon my request.

Elizabeth K. O’Dea, Author
ACKNOWLEDGEMENTS

The author wishes to thank Ethan Smith and others in the Tahoma School District, Washington, who were crucial in the success of this project by providing a testing ground for the Tahoma Virtual Atlas as well as assistance in acquiring data. This project also would not have been possible without the constant support of Dr. Dawn Wright. Her optimism and encouragement were a great help down the long road of graduate school, and her drive and positive attitude are an inspiration. I would also like to thank committee members Dr. Greg Gaston and Dr. Charles Rosenfeld. Dr. Gaston’s encouragement and direction particularly during overwhelming times were much appreciated. I would also like to thank Dylan Keon, the creator of the H.J. Andrews Experimental Forest ArcIMS site, who was a key resource when I encountered ArcIMS challenges.

Appreciation also goes out to fellow geography graduate students, too many of them to name here. Without their camaraderie and support through the difficult times, I would not have made it this far. Finally, thank you to my parents. Words cannot describe how much their constant support, encouragement, and love throughout my life have meant to me.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>1.1. OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>1.2. OBJECTIVES</td>
<td>5</td>
</tr>
<tr>
<td>2. BACKGROUND</td>
<td>7</td>
</tr>
<tr>
<td>2.1. WEB GIS</td>
<td>7</td>
</tr>
<tr>
<td>2.2. GIS IN SECONDARY EDUCATION</td>
<td>13</td>
</tr>
<tr>
<td>2.2.1. Current Status</td>
<td>15</td>
</tr>
<tr>
<td>2.2.2. Issues for Educators</td>
<td>17</td>
</tr>
<tr>
<td>2.2.3. Efforts to Increase Use</td>
<td>20</td>
</tr>
<tr>
<td>3. TAHOMA VIRTUAL ATLAS</td>
<td>23</td>
</tr>
<tr>
<td>3.1 METHODS</td>
<td>25</td>
</tr>
<tr>
<td>3.1.1. Planning and Design</td>
<td>25</td>
</tr>
<tr>
<td>3.1.2. Data Compilation and Processing</td>
<td>28</td>
</tr>
<tr>
<td>3.1.3. Installation and Web Site Creation</td>
<td>33</td>
</tr>
<tr>
<td>3.1.4. Implementation</td>
<td>40</td>
</tr>
<tr>
<td>3.2. THE FINAL PRODUCT</td>
<td>41</td>
</tr>
<tr>
<td>4. OBSERVATIONS</td>
<td>45</td>
</tr>
<tr>
<td>5. CONCLUSIONS</td>
<td>48</td>
</tr>
<tr>
<td>5.1. VIABILITY OF WEB GIS IN EDUCATION</td>
<td>48</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS (Continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1.1. Web GIS in Education</td>
<td>48</td>
</tr>
<tr>
<td>5.1.2. Community Mapping</td>
<td>50</td>
</tr>
<tr>
<td>5.1.3. Challenges and Benefits</td>
<td>52</td>
</tr>
<tr>
<td>5.2. RECOMMENDATIONS</td>
<td>54</td>
</tr>
<tr>
<td>5.3. FUTURE WORK</td>
<td>55</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>57</td>
</tr>
<tr>
<td>APPENDICES</td>
<td>63</td>
</tr>
<tr>
<td>Appendix A. GIS Data Sources for the Tahoma Virtual Atlas</td>
<td>64</td>
</tr>
<tr>
<td>Appendix B. Comprehensive ArcIMS 3.1 Installation Guide</td>
<td>65</td>
</tr>
<tr>
<td>Appendix C. ArcIMS 3.1 Site Creation and Maintenance Guide</td>
<td>76</td>
</tr>
<tr>
<td>Appendix D. Tahoma High School Teacher Survey</td>
<td>83</td>
</tr>
<tr>
<td>Appendix E. Potential Local Base and Environmental Data Sources</td>
<td>84</td>
</tr>
</tbody>
</table>
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The ArcIMS Architecture</td>
<td>10</td>
</tr>
<tr>
<td>2. The ArcIMS Manager Interface</td>
<td>11</td>
</tr>
<tr>
<td>3. Locator Map of King and Pierce Counties, Washington</td>
<td>24</td>
</tr>
<tr>
<td>4. Example of poor matching of layers supplied by neighboring counties</td>
<td>32</td>
</tr>
<tr>
<td>5. Authoring a MapService in ArcIMS Manager</td>
<td>34</td>
</tr>
<tr>
<td>6. Selecting tools as part of designing the ArcIMS web site</td>
<td>36</td>
</tr>
<tr>
<td>7. The toolbar portion of the help page</td>
<td>37</td>
</tr>
<tr>
<td>8. The metadata index page for the Tahoma Virtual Atlas</td>
<td>39</td>
</tr>
<tr>
<td>9. Opening view of the Tahoma Virtual Atlas</td>
<td>42</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1. OVERVIEW

In his plenary address to the Environmental Systems Research Institute (ESRI) Education User Conference, Dr. Robert Downs stated that geographic information systems (GISs) needed to become as ubiquitous in the educational system as the yellow pencil (Downs 2001). The benefits that GISs can bring to education are numerous. Their data viewing capabilities can enhance curricula by assisting students in learning geographic and spatial reasoning issues, while their data analysis functionality can help to develop students’ problem solving skills. Their interdisciplinary nature make them an ideal educational tool for teaching about real-world issues (Audet and Paris 1997, Kerski 2001, Meyer et al. 1999). The interactive and visual nature of GISs are generally more interesting to students and have been shown to increase students’ learning in comparison to traditional...
methods, especially among average and below-average students (Kerski 2001, Linn 1997). In sum, a GIS is a good complement for secondary science education, particularly in more student-centered classes where students are active participants (Audet and Paris 1997).

In comparison to its rapid growth in the professional sector, however, the use of GISs in K-12 schools has moved at a very slow pace. GISs offer a useful tool for educators to teach students about local and global communities in various subjects, particularly the sciences, but the growth in its usage is hindered by many teachers’ limited time and access to resources necessary to adequately learn the complexities of a GIS software package such as ArcView, a product of ESRI. A full GIS can be overwhelming to any novice because of its vast range of capabilities. It has been estimated that less than 2% of high schools in the United States have adopted GISs, and approximately only half of those high schools actually use it (Kerski 2001). The limited success stories are largely due to highly motivated teachers who devote much of their spare time to learning the software and designing lesson plans, as well as to GIS professionals and organizations from the community who offer their assistance. The reality is that most teachers cannot take the time needed to adequately learn the software and create lessons on top of their regular teaching duties. For teachers wishing to use local data in their lessons, the challenges can be even greater.

Many of the GIS data sets currently being used in schools are of global communities because those layers accompany the software and are easily
accessible, but experience shows that students are more motivated to learn when the data pertain to their local community (Alibrandi 1998, Meyer et al. 1999). Students are excited when they can find their street, recognize their house in an air photo, or discover that a fault line passes only a mile from their home. By analyzing various GIS layers from their surrounding community, students find the information more pertinent to their lives and are more likely to be interested in the curriculum. Through learning about local scientific and geographic issues, students can then use this knowledge to better understand broader global issues. Many teachers also prefer using local data sets because they open the door for more teaching possibilities, particularly in combining interactive mapping and spatial analysis with community field trips. For the inexperienced teacher learning to use a GIS, however, acquiring local data is a challenging and often frustrating task if there is no GIS professional to offer assistance. The problem is exacerbated when the data come from various sources that use different data formats and projections.

Due to its complexities, many educators who teach with a GIS as an aid must devote much of their time to teaching the technology of the GIS, when the focus should instead be on using the GIS as an educational tool that enhances their curriculum (Audet and Paris 1997, Meyer et al. 1999, White and Simms 1993). While using computer technology in education is vital for keeping students current with its rapid growth in society, educational standards restrict the amount of time teachers can devote to teaching a single software package such as ArcView. The importance of GIS use in education is not so much the technology but its ability to
help students to better understand geographic concepts and spatial interactions within a community. Less complex options need to be explored and developed in order for GISs to be more easily accessible to more teachers and students. Only then will the K-12 educational system see a significant increase in GIS use.

The recent development of web GISs provides one potential solution to some of these challenges. An integration of GIS capabilities with Internet technology, web GISs provide an application with which standard GIS operations can be performed over the Internet without the need for local software (Longley et al. 2001, Xue et al. 2002). This new technology offers schools a way to incorporate GISs into curricula by providing some of the basic functionality of a full GIS, as well as the appropriate data sets, in a way that is accessible via the Internet without the need for GIS software or data on local computers (Green 2001a). A web GIS can be accessed from most Internet-accessible computers, allowing students and teachers the ability to access a GIS from inside and outside of the classroom. The interface of a web GIS is less complex than the multiple windows and menus of a full GIS such as ArcView, thus making it easier for novices to use. It is hypothesized here that the user-friendly nature of a web GIS potentially makes it simpler for both teachers and students to learn to use a GIS, and therefore is less intimidating and time consuming for educators to teach. This opens up the world of GISs to teachers who otherwise would not have the time or resources to learn and teach using a full GIS such as ArcView, and thus has the
potential to bring GIS one step closer to becoming an integral pedagogic tool used in secondary education.

1.2. OBJECTIVES

This study investigated the use of a web GIS as one approach for teachers to more easily incorporate a GIS and community mapping into secondary science education, thus providing teachers with a method of using a GIS as a pedagogic tool instead of a cumbersome program that requires focus to be placed on teaching the technology of GIS. The following objectives were based on selections from a list of principle research issues for GIS use in K-12 education (National Council for Geographic Education 1996):

1) Determine if a web GIS is a viable option for easier GIS integration into secondary science curricula through the creation of a model community atlas,

2) Identify benefits and limitations of web GIS use in education,

3) Establish some of the factors of success required to make the use of web GISs in education a reality.

To study the feasibility of a web GIS as a pedagogic tool, a model virtual physical geographic community atlas was created using Arc Internet Map Server (ArcIMS) software, a web GIS product of ESRI. Local data were collected and
compiled. After ArcIMS was installed, the Tahoma Virtual Atlas was created using the local data and then the web site was customized. Once completed, the atlas was introduced to science teachers in the Tahoma School District in Washington, and will be integrated into their secondary science curriculum.
2. BACKGROUND

2.1. WEB GIS

While GISs have existed for over three decades, the development of web GIS is a recent phenomenon. When the Internet became popular around 1995, it developed as a great resource for networking GIS data. It has since provided the opportunity for many organizations to save time and money by making their data sets available to the public via the World Wide Web (Chueng and Brown 2001). The variety of types in distributed geographic information (DGI) applications has grown since then, consisting of a wide variety of formats ranging from static and dynamic map images to more advanced web GISs that offer greater functionality (Green 2001b). With the development of web GISs, the Internet is now becoming a portal for GIS functionality as well as data distribution. This development is following a natural progression of increasing efficiency in GISs (Chueng and Brown 2001). Those same agencies that distribute data are now recognizing the benefits of bringing the capabilities of GISs online in order to display that data to the general public. Versions of web GISs have been continually improving in functionality, from simple data viewing abilities to performing spatial analysis and collaborative efforts in real time from remote locations (Plewe 1997). Some
experts predict that web GIs may eventually become the dominant format for accessing GISs (Longley et. al. 2001).

Web GISs provide a simple online interface that both GIS novices and experts can use to access GIS functionality and view data sets without requiring software or data on the user’s computer, thus moving beyond the mere posting of static maps of roads or geographic features on a web page (Isaacs 2000). Users can look at areas of interest, select which layers they wish to display, query data sets, and even buffer features. Many organizations that are creating web GIS services are looking for ways in which to reduce public demand for information by providing a utilitarian online resource that can meet some of these demands. An example of this is Pierce County, Washington’s MAP Your Way web site, which provides spatial information to the public such as zoning, bike routes, school districts, and hospitals (Pierce County: http://triton.co.pierce.wa.us/index.htm).

Sites are also created to meet specific needs, such as the US Geological Survey’s (USGS) Wildfire Information site, which displays an interactive map of current wildfires around the nation (United States Geological Survey: http://wildfire.usgs.gov/website/fireinfo/viewer.htm). This site provides an important tool for wildfire fighting professionals, and also indirectly serves as an informational and educational resource for the public. Prior to the technology of web GISs, these organizations would have had to spend more time and money by disseminating GIS data to GIS professionals using other digital means, as well as their products to members of the public who requested information. A web GIS provides a good
method of disseminating spatial information to many people in a much simpler form than traditional methods, while saving time and resources.

With the current level of functionality of a web GIS, the concept is ideal to use in lieu of a full GIS program for users that only have simple GIS needs. It provides a method for people who do not have in-depth GIS skills to view data specific to an area of interest by using a simplified interface that the site creator can customize to meet specific needs. A full GIS requires the local installation and licensing of expensive software as well as powerful hardware that has a lot of storage space for the typically large GIS data sets. With a web GIS this is not as much of an issue for anyone but the site administrator. All a computer needs to have in order to access a web GIS site is an Internet browser and a relatively fast Internet connection. It helps to have a fast processor and modem, as well as a large amount of random access memory (RAM) so that the computer can more easily handle the large processes (Green 2001c).

ESRI’s Arc Internet Map Server (ArcIMS) is the one of the most advanced web GISs currently on the market, competing against products such as Autodesk MapGuide, Intergraph GeoMedia Web Map, MapInfo MapXtreme, and the open source, public domain GRASS Links (Longley et al. 2001). On top of the basic functionality of viewing and querying data, it can be designed to provide an environment where data collaborators can edit data sets remotely and overlay local GIS data sets on top of data sets viewed online. It is designed to be used by novices and professionals alike and can be customized to meet users’ needs.
The basic structure of ArcIMS consists of the server (the distributor) and the client (the viewer) functions. The server is the computer on which the web GIS and data are stored, as well as where all of the client requests are processed and then sent back to the client over the web. ArcIMS requires several software programs in order to run on the host machine, including a web server, a servlet engine, and a web browser on the client’s end. The architecture of ArcIMS consists of several components, all located on the host computer (Figure 1). The ArcIMS Spatial Server is where all of the client requests are processed. The ArcIMS Application Server acts as a secretary, handling the requests and keeping track of what and where services are running. ArcIMS uses ArcXML to structure...
data, which is a variation of Extensible Markup Language (XML). XML, which was developed by the World Wide Web Consortium (W3C), is the increasingly dominant language for storing data on the web because of its more adaptable way of identifying information over the Internet (Flynn 2002). Using the ArcXML language, the ArcIMS Application Server Connectors are used by the web server and the Application Server to communicate with each other. ArcIMS Manager is

Figure 2: The ArcIMS Manager interface.
the web-based interface where the MapServices (the files that store the spatial data that are displayed online) are created, the web pages designed, and the sites are administered (Figure 2). Data sets used to create a MapService can be stored like most files on a computer, or in a relational database management system (RDBMS) from which Arc Spatial Database Engine (ArcSDE), another ESRI product, conveys spatial data. ArcIMS software is accompanied by ArcSDE for Coverages, which is a simpler version that allows ArcIMS to read ArcInfo coverages as if they were coming from a RDBMS through ArcSDE. For basic ArcIMS sites that do not distribute many data sets to many users, however, ArcSDE is not necessary to use. Finally, the ArcIMS Viewers determine how the web site will be displayed, and two options are provided. The HTML Viewer has limited functionality but is more widely accessible, while the Java Viewer has greater functionality but has limited accessibility (ESRI 2001).

In order for a client to view an ArcIMS site, the requirements depend on the type of viewer used to display the site. The more complex Java Viewer can only be accessed using a web browser that supports Java plug-in functionality such as Internet Explorer, and a one-time download of the Java plug-in on the client’s computer is necessary. It requires more powerful client machines in order to handle local processing for greater GIS functionality. The HTML Viewer is accessible from multiple browser types without requiring plug-ins, and is best used for simpler GIS functions such as viewing and querying data. All of the processing with the HTML Viewer is done on the server (ESRI 2001).
2.2. GIS IN SECONDARY EDUCATION

The interest in incorporating GIS into secondary education is growing as teachers learn about the many benefits that its use can bring to the classroom. Its display of spatial data helps students to recognize and comprehend spatial patterns, while the variety of data and subject matter demonstrate real world complexities (Kerski 2001). It is an ideal tool for teachers who wish to use more student-centered teaching methods where students play an active part in the learning process, challenging students to think more independently and critically (Fitzpatrick and Maguire 2000, Thompson and Buttenfield 1997). Making geography and related subjects more interesting to students because of its visual and interactive nature, a GIS challenges students to ask questions, research problems, identify relationships, interpret data, and develop theories based on information presented to them. Instead of just reading about results, students can use a GIS to perform geographic and scientific analysis, which encourages exploration and abstract thinking (Kerski 2001, Mackaness 1994).

While students need to learn how to understand standard geographical tools long used to interpret spatial data, they also need to learn how to use and understand the concepts of GISs, which are becoming as essential as maps themselves. It is much easier for teachers to fall back on traditional mapping methods when they are restricted in time and technological resources. While it is critical for students to be exposed to traditional mapping methods, it is also
important for them to experience current tools and methods used by professionals in dealing with spatial data (Green 2001b). The increasing importance in universities and many work environments makes it critical to expose students to computer technology in secondary education. A GIS provides a good way to do that because it combines interaction and visualization with technology, while complimenting traditional tools (White and Simms 1993). In comparison to traditional learning methods, a GIS combines the visual, spatial tool of a map with information-rich data tables, along with spatial analysis functionality. At the same time it provides a better way for students to understand issues of resolution and scale (Mackaness 1994).

The benefits of students’ use of a GIS in education can carry beyond the time spent in school. Their familiarity with a GIS and spatial concepts can help students in the job market because more and more organizations are using GISs in the workplace (Goodchild and Kemp 1992). Employers are recognizing the value of the skills and perspective a geographer can bring to any field that deals with information spatially (Kemp et al. 1992). In fact, GIS perspectives are included in three-fourths of corporate decision-making (Audet and Paris 1997). The multidisciplinary nature of GISs can be seen in the diverse range of organizations that use them, from environmental research to urban planning. Therefore any experience that can expose students to concepts of GISs may open doors for them in the future.
2.2.1. Current Status

While there is growing interest shown by educators to use GISs in their teaching, few have successfully integrated them. One study showed that nearly half of teachers who own a GIS do not use it (Kerski 2001). Teachers may recognize the benefits that a GIS can bring to their classrooms, but when they encounter major challenges, their motivation may dwindle (Audet and Paris 1997). They have generally been adopted by non-technophobic veteran teachers who could devote the time to learning the software and creating curricula (Kerski 2001). In many current school systems teachers do not have the time needed to become proficient users of a GIS, particularly while having to meet state and national education standards. A GIS requires active learning beyond training in order to gain such proficiency. While the most practical solution is for school districts to hire GIS coordinators, most do not have the resources to do so and very few are known to exist (Moore 2001). Instead, ambitious teachers and/or outside organizations have created many of the existing school GIS projects, ranging from studying global themes such as ecosystems and climate zones to studying local community issues such as The Community Geography Project’s wetlands conservation project in Portland, Oregon (Malone et al. 2002, Merrick 2001).

Some secondary education is currently in the midst of a transition from teaching single disciplines towards integrated education. Educators are recognizing the benefits of integrating subjects in their curricula because they understand how it
better reflects the real world. A GIS is a beneficial tool for integrated education because it focuses on geography while pulling together other relevant subjects (Green 2001b). Integrated science courses are one ideal example of the logic of this method of teaching. In studying watershed health, for example, lessons can incorporate biology, chemistry, earth sciences, social studies, and mathematics. This shift to integrated education is accompanied by a change in classroom teaching towards inquiry-based learning, where classes focus on students’ learning through problem solving, as opposed to teacher-focused learning (Kerski 2001). A GIS is an ideal tool for bringing these things together and demonstrating interactions among disciplines.

Despite the limited use of GISs in secondary science education, several examples of successful use can be found. Many of the successful projects are due to the assistance of outside organizations. Science education projects are common, using ArcView for a diverse range of lessons from studying global themes such as plate tectonics to studying local community issues such as watershed health (Lassen High School 2001, Wager 2002). Organizations such as the Orton Institute (http://www/communitymap.org) help teachers by leading training sessions in community mapping using a GIS. Internet map servers have also been used to complement watershed studies. The Thornton Creek Project (http://www.thorntoncreek.org) and Map-IT! (Curtis et al. 1999: http://archive.ncsa.uiuc.edu/Cyberia/RiverWeb/Projects/mapit/Instructions/instructions.html) use ArcView IMS, the predecessor of ArcIMS, which is more limited in its functionality. In
terms of lessons that are more geographically generic (global and national scales as opposed to local), ESRI provides a web site where teachers can acquire and share lessons using GIS (ESRIa: http://www.esri.com/industries/k-12/lessons.html). A newly published book of lessons, *Mapping Our World*, also provides a useful resource for teachers with lessons that study various aspects of physical and human geography (Malone *et al.* 2002).

2.2.2. Issues for Educators

Full GIS packages provide many challenges for teachers. Obstacles encountered are often formidable and can only be overcome by determined and motivated teachers (Audet and Paris 1997). A common reason for their lack of use in education is that many teachers are intimidated by the technology (Green 2001a). Without assistance from outside sources, it can be hard for teachers inexperienced in using a GIS to overcome the obstacles of time and resources needed for successful use.

Time is one of the major factors in the success of GIS use in schools. It takes much time for teachers to attend trainings and gain enough experience using the technology to become proficient due to the complexities of a full GIS (Audet and Paris 1997, Cheung and Brown 2001). It is a continual learning process for both teachers and students. A lot of effort is required to develop and maintain a
GIS as well as accompanying lessons, and mostly on teachers’ own time (Audet and Paris 1997, Kerski 2001). Time is also a factor in the classroom. Often most of the time devoted to student GIS projects in classrooms is spent learning GIS technology (Meyer et al. 1999). This takes class time away from meeting core education requirements.

Resources are the other major limiting factors for GIS use in education. Access to adequate technology can be a large problem (Chueng and Brown 2001). Computers need to be powerful enough to handle processing and large data sets. Schools also need enough computer resources to be able to adequately accommodate class sizes. Funding resources add to the challenge, particularly when starting up a GIS (Audet and Paris 1997). Money is needed for hardware, software, teacher training, and potentially data as well. Often, tight school budgets limit the number of interested teachers that can be sent to training sessions, and it is challenging to learn GIS packages without attending training of some sort. School politics and structural issues can play into many of the resource issues (Kerski 2001). Finally, there is a lack of curriculum resources that involve a GIS, which is a major factor for all levels of K-12 education. Many teachers need to develop lessons from scratch that meet educational standards, which requires significant time (Audet and Paris 1997, Kerski 2001). Some lessons have been developed using ArcView and ArcExplorer and are accessible online and through books, but there is still much work that can be done to assist teachers (ESRI 2002, Malone et al. 2002).
A common complaint among teachers wishing to use a GIS is that they must devote too much class time to teaching the technology because of software complexity, instead of using it as a tool to complement their curriculum. Few teachers are willing to do this if it takes time away from teaching students what they need to know in order to meet educational standards. When incorporating a GIS, teaching and learning methods therefore need to be altered by shifting away from teaching the technology of a GIS (Kerski 2001). In order to do this, developing easier GIS software is needed.

Educators are also concerned about how a GIS can be incorporated into curriculum while helping them to meet education standards. In looking at national geography standards, numerous ones can be learned with the help of a GIS, particularly within elements such as “The World in Spatial Terms” and “Physical Systems.” Standard Three entails students being able to analyze spatial relationships of places and the people and environments within them, while Standard Seven requires students to understand how patterns on the earth’s surface are shaped by physical processes (National Council for Geographic Education 1998). Washington state educational standards also offer potential for GIS applications. Benchmarks for the tenth grade require students to be able to analyze various human impacts on the physical environment. Other subject standards, such as communication and science, can also be positively influenced by the use of a GIS by offering opportunities for students to work together and communicate ideas,
and to better understand scientific concepts through hands-on lessons (Washington Office of Superintendent of Public Instruction 2002).

2.2.3. Efforts to Increase Use

As interest in the use of GIS for K-12 education has grown, organizations have sought to develop central sources of ideas and places for discussion. Centers and organizations such as the National Council for Geographic Education (NCGE), the National Geographic Society (NGS) and the National Center for Geographic Information Analysis (NCGIA) have played a critical role in setting the standards and providing resources for teachers as components of their services, such as ideas on how to implement a GIS and what areas need further development (Goodchild and Kemp 1992, Green 2001b, Thompson and Buttenfield 1997). Organizations are also working with schools to assist teachers in incorporating GISs. Nonprofit organizations such as the Center for Image Processing in Education (CIPE; http://www.evisual.org) and the Orton Institute (http://www.communitymap.org/), university groups such as the Nature Mapping Program out of the University of Washington (http://www.fish.washington.edu/naturemapping/onek12.html), and government organizations such as the City of Phoenix provide GIS services for educators that make incorporating the technology

Efforts have been made to create programs that make it easier for teachers to incorporate GISs into their classrooms, but there is no simple solution for such complex software without losing much of its functionality. As the designer of the most widely used GIS software worldwide, ESRI has made strong efforts in providing schools with some resources as well as watered down GIS products with simpler interfaces and functions than those of full GIS packages (Green 2001a). They have developed programs such as ArcExplorer (a simplified version of ArcView) and ArcVoyager (a guide that works with ArcView to teach about geography and GIS) that make GISs easier to use and understand. They also provide numerous free global data sets with which educators can work. While teachers have found these programs and lessons useful in learning and teaching about GISs and geography, there are still challenges, such as program installation and data issues.

A number of GIS workshops and training sessions led by a variety of organizations are available to teachers around the United States, ranging in length from a couple of hours to a couple of weeks. Examples of this include the CIPE’s Visualization Technology in Education (VisTE) Institute held annually, as well as numerous national trainings led by various organizations listed on the GIS for Teachers: Training and Education Programs web site (KanCRN Collaborative Research Network: http://kangis.org/learn/). Many of them involve the use of
ESRI’s ArcView or ArcExplorer software. Other resources are online GIS courses and tutorials, such as those taught at the ESRI Virtual Campus (ESRIb: http://campus.esri.com). These training sessions and tutorials are good methods of exposing teachers to important geographic concepts and GIS benefits, but they usually skim the surface of more advanced topics due to limited time. In order to truly become skilled with the software, teachers should continually use it in order to retain what they have learned. This can be challenging due to lack of time as well as technical support when problems occur that teachers cannot solve.
3. THE TAHOMA VIRTUAL ATLAS

The author developed a project based on discussions between her and Ethan Smith, a friend who teaches secondary earth and integrated sciences for the Tahoma School District, located around Maple Valley, Washington (Figure 3). Secondary science educators in the Tahoma School District were very interested in incorporating a GIS into their integrated science curriculum but, like many teachers, were limited by time and resources needed to properly learn the software and develop lessons using it. While the school district acquired ArcView GIS in 1999, implementation into the curriculum has been slow. One teacher was selected to attend a short ArcView training, and in return was expected to develop a GIS program for the district’s secondary science program and train the other teachers in how to use it, on top of his regular teaching duties. It was several months before the teacher was able to develop a lesson about earthquakes using global data sets that accompanied the ArcView software. While the global and national data sets are useful for some purposes, teachers said that they would prefer to use local data sets that they could incorporate into their science courses and field trips. The challenge for them lay in not knowing where to begin in finding local data sets and what to do with them once they were found.

As a way to investigate the use of web GISs in education, an online physical geographic atlas of their community was proposed to serve as a single source for
Figure 3: Locator map of King and Pierce Counties, Washington.
exploring local data and GIS technology through the use of ArcIMS. The Tahoma Virtual Atlas was designed to fit some of the spatial data needs of secondary integrated science teachers in the Tahoma School District who wished to incorporate a GIS into their curriculum. The atlas covers Pierce and King Counties in Washington (Figure 3) and contains a variety of spatial data sets, primarily base data (such as roads and political boundaries) and physical geographic data (such as geology and wetlands). Physical geography was chosen as the theme of the atlas because of its collaborative nature for studying community interrelationships by blending biological, environmental, and earth system sciences with the spatial aspect of geography (Walsh 1988). The teachers’ desire was to have a GIS tool that could be used in combination with their local field studies in order to enhance their analyses, incorporate geographic concepts, and encourage improvement of students’ problem solving skills, as well as provide an option for data set expansion. The atlas was designed with the intent of meeting those needs.

3.1. METHODS

3.1.1. Planning and Design

After extensive research on the use of GISs in secondary education, web GIS, and online atlases, a plan was developed for the Tahoma Virtual Atlas. The
atlas was initially designed with a physical geographic theme in mind so as to contain a variety of layers that would be relevant to the study of different sciences in the Tahoma School District’s secondary integrated science curriculum, which is a part of their efforts to develop integrated curriculum district-wide in order to connect learning activities and life experiences with the combined content of subjects that were once taught independently (Tahoma School District 2002). For relational purposes, base layers such as roads and political boundaries were also included. The primary goal of the atlas was not only to provide science educators with an easy way to access a variety of local GIS data sets, but to also provide a base on which teachers would be able to add more data sets after the atlas was completed.

In February 2001 a meeting was held with several science teachers at Tahoma High School, located near the town of Maple Valley, Washington (Figure 3). At the meeting the teachers, some unfamiliar with GISs, were given a brief introduction of GISs and web GISs. A demonstration was given using an existing ArcIMS site to show the functionality and ease of use that a web GIS could provide. The concept of the Tahoma Virtual Atlas was then introduced. The benefits and drawbacks of ArcIMS versus ArcView were discussed, and teachers voiced concern over the time that it would take to learn and teach using the atlas, as well as how it could be used to help them to meet educational standards. A list of ideal layers to place in the atlas was presented, discussed and modified (See table). The layers were then ranked by priority based on which data sets would be most
The initial list of layers for the Tahoma Virtual Atlas. Starred layers were designated as priority by the teachers.

<table>
<thead>
<tr>
<th>Base Data Layers</th>
<th>Physical Geographic Layers</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Roads</td>
<td>* Vegetation</td>
</tr>
<tr>
<td>* Streams</td>
<td>* Geology (surface, fault lines, earthquakes, landforms, landslides)</td>
</tr>
<tr>
<td>* Digital Elevation Models (DEM)</td>
<td>* Climate (precipitation, temperature)</td>
</tr>
<tr>
<td>* Contour Lines</td>
<td>* Land Use</td>
</tr>
<tr>
<td>* Political Boundaries</td>
<td>Slope and Aspect</td>
</tr>
<tr>
<td>* Cities</td>
<td>Forest Harvest Units</td>
</tr>
<tr>
<td>* Watersheds</td>
<td>Wetlands</td>
</tr>
<tr>
<td>Township/Range/Section Grid</td>
<td></td>
</tr>
<tr>
<td>Digital Orthoquads (DOQs)</td>
<td></td>
</tr>
<tr>
<td>Quad Boundaries</td>
<td></td>
</tr>
<tr>
<td>Trails</td>
<td></td>
</tr>
</tbody>
</table>

useful for the teachers’ intended purposes for the atlas. The area to be covered by the atlas was also discussed. Pierce and King Counties were chosen as the coverage area in order to incorporate most of the areas where science field trips were taken. The teachers recognized that acquiring full coverage for each theme was a challenge in the given timeframe. It was decided that collection of complete data sets would be attempted, but priority would try to focus on science field trip sites. Those sites listed were the Cedar River Watershed and the Rock Creek Watershed within it, the Green River Watershed, the north side of Mt. Rainier, Discovery Park, Cougar and Tiger Mountains, and Deception Pass.
3.1.2. Data Compilation and Processing

Numerous web sites were explored in order to find sources of GIS data for the atlas, which included federal, state and county agencies, as well as nonprofit organizations and universities. The search included vector and raster data, as well as grids and georeferenced images. Some data sets were downloaded at no cost from the Internet. Others were delivered on CD, such as the data from both King and Pierce Counties, which were ordered via online order forms. Due to the Freedom of Information Act, many data sets were available from government agencies for free. When ordering data on CD however, a fee was charged for the GIS professional’s time used to put the CD together. Organizations that made their data downloadable from the Internet were the easiest to acquire. Some information was also acquired from the Friends of Rock Creek Valley, including tabular data about land as well as a set of historic air photos for a small area within Rock Creek Valley (a portion of the area surrounding Maple Valley). While collecting all of the data sets, a variety of information about the data was recorded: the source organization, web site, how it was acquired (download or CD), original projection, scale at which the data was created, the metadata file name, and contact person/organization. In the event that the teachers have questions about the data or wish to update any data sets, they will have the information necessary (Appendix A).
Metadata (information about the data sets) were also downloaded when they were available. The metadata are critical for teachers and students to be able to access because, among other things, they provide information about what data attributes mean, which are sometimes represented by numbers or abbreviations that are hard to understand. Metadata also include information about who created the data sets, on what date they were created, and the resolution at which they were created. This information is important so that the user can determine how useful a data set is at different scales, and if it is recent enough to be relevant to their study.

Varying levels of metadata quality were found. Some owners provided no metadata; some provided “light” metadata that did not define the attribute abbreviations; others were compliant with Federal Geographic Data Committee (FGDC) content standards, containing many of the required elements. This inconsistency in metadata quality is a common issue when dealing with data sharing because some organizations do not make metadata creation and maintenance a priority, and when those data sets are shared, their quality is minimized because the data knowledge is not passed along with it.

Once the data were collected, the next challenge was to process and integrate them. The data processing was done using a combination of ArcView 3.2 and ArcInfo 8.1. Several factors had to be considered. Data came in different file formats (an ArcInfo compressed .e00 file, an ArcView shapefile, or a grid, for example). Because ArcIMS uses ArcView shapefiles for its display (if ArcSDE for Coverages is not used), most of the files had to be converted into that format, with
the exception of grids and images. Projection was a crucial integration factor. Many of the data sets had to be converted to a common projection so that they would all overlay each other correctly. The State Plane Coordinate System was chosen because a majority of the data came from the counties who both use State Plane, North American Datum (NAD) 83 High Accuracy Reference Network (HARN), with the units as feet, and based on the Lambert Conformal Conic projection. Because Pierce County is located in the Washington South zone and King County is in the Washington North zone in the State Plane projection, all Pierce County data were converted to Washington North. This was chosen because the school district resides in King County. The distortion of county data was not significant enough to be a major issue for the purposes of this atlas. Another issue was the scale of the data. Because the data’s intended use is to be at a local scale, some data were thrown out if they were created at too small a scale to be useful for their purposes. For example, a national surface geology data set available from the USGS provided too little detail (small cartographic scale) to be useful when studying a watershed. Finally, data variability was considered. Different data sets were created at different resolutions, so at a watershed level the higher resolution data were more likely to be accurate.

Some data processing was needed beyond file and projection conversion. A ten meter digital elevation model from the University of Washington was used to create several new layers using ArcInfo 8.1 Spatial Analyst: 20-foot contours, 100-foot contours, slope, aspect and shaded relief image. The slope and aspect layers
had to be converted from raster grid format to vector polygon format in order for them and their attribute tables to be displayable in ArcIMS. Once finished, the layers had to be converted from ArcInfo coverages into shapefiles. A shaded relief grid was also created in ArcInfo Spatial Analyst. Because ArcIMS cannot easily display grid data when not using the Java Viewer or ArcSDE, the file had to be exported as a spatially referenced geographic image, which is an image that is accompanied by a “world file” that contains the image’s spatial reference coordinates. In this project the file was exported as a GeoTIFF image, consisting of an image file (extension .tif) and a matching world file (extension .tfw).

In some cases where similar neighboring data sets needed to be joined, such as stream layers from different counties, matching the features themselves as well as their attributes was a major issue. County stream layers provide a good example. In terms of features, the streams layer provided by King County consisted of single arcs denoting the central path of the streams (Figure 4). The streams layer from Pierce County, however, consisted of arcs delineating the stream edges, thus showing where wider stream segments were located. The locations of the stream paths themselves were also significantly different. This made it very difficult to accurately join these two coverages together, and a different streams layer from another source had to be found that would cover the area of both counties and be consistent. Another compilation issue was in matching the contents of the attribute tables attached to the spatial data, where the tables had to be manipulated so that the two layers could be joined together. In
some cases, the procedure needed was too time-consuming and so the layers and their attribute tables were not joined, and the layers were added separately to the atlas. Other factors, such as different resolutions or original scales, also influenced these decisions.

Figure 4: Example of poor matching of layers supplied by neighboring counties. The streams in this image are within the overlapping area of both counties' data sets.
3.1.3. Installation and Web Site Creation

The installation and functions of ArcIMS were learned via a separate, ongoing project called the Virtual Research Vessel (VRV; Wright et al. 2002: http://osu.orst.edu/dept/vrv/index.html). Funded by the National Science Foundation, the project’s goal is to develop an online computational environment where researchers and educators can access actual geological, geophysical, hydrothermal, and biological data from a segment of the East Pacific Rise seafloor-spreading center. ArcIMS was used to develop the web GIS component of the VRV, which will later be linked to a data model, a relational database management system, and a numerical modeling module (Wright et al. in press). ArcIMS (version 3.0 and later version 3.1) was installed on a computer with a 800 Mhz, dual processing Dell Precision Workstation220, with 384 Mb of RAM in each processor, and running Windows 2000 Workstation (not Server). For the web server, Apache Web Server 1.3.23 and Jakarta Tomcat 3.2.3 were selected because they were free and said to be stable and secure, and were installed prior to ArcIMS. After much troubleshooting, an ArcIMS site was developed and customized to make the site more user friendly. The skills learned from this project were of tremendous help in the creation of the Tahoma Virtual Atlas.

Installation of ArcIMS was a long and frustrating process, as there were a number of programs from different sources that had to be installed and working correctly prior to the installation of ArcIMS itself, such as Apache Web Server,
Jakarta Tomcat Servlet Engine, and Java™ 2 SDK with Java Runtime Environment (Appendix B). Once everything was installed and running correctly, the Tahoma Virtual Atlas was created, a much simpler process than the software installation. ArcIMS Manager, which walked through all the steps needed to create a site, was easy to follow with the help of the Using ArcIMS guide that accompanied the software (ESRI 2001). The first step was to author a MapService. To do so, a map configuration file was created, which was the file containing all of the GIS data to

Figure 5: Authoring a MapService in ArcIMS Manager.
be displayed on the ArcIMS site. This was where GIS data were added and details such as colors, symbols, labels, and scale dependency for each layer were chosen (Figure 5). Due to the large number of layers to be added, special care had to be given to selecting colors, fill patterns, and point and line symbols that would be visually pleasing as well as appropriate for their purposes. For example, watershed polygons needed to be semitransparent in order for the viewer to see underlying features such as geology. Once the map configuration file was created, a MapService had to be produced. The Image Server option was selected as the virtual server (as opposed to the Feature Server, which requires Java in order to view the site) because that is what was required in order to create a site using the HTML Viewer.

The next step was to design a web site using ArcIMS Manager. This is where the web site was named and the MapService to be displayed on the site was designated. The HTML Viewer was selected for the web site design because of its broader accessibility from different platforms and browsers, one of the key goals of the Tahoma Virtual Atlas. The layers to display when the site is initially opened were selected, and the properties for the scale bar were set. Deciding on the viewer functionality was the next step, which involved selecting which tools were to be available on the web site. The full range of tools provided for the HTML Viewer were chosen in order to maximize the functionality of the atlas, including tools such as Query Builder, Buffer, and Print (Figure 6). Finally, Identify Results were set for each layer, in which the table fields were chosen that would be displayed to
the viewer when the Identify tool was used. This is useful when tables contain many fields that are not relevant to the purpose of the web site. Once prompted to designate the web site directory, the site was created.

After the initial ArcIMS site was created, it needed to be customized because the default site that was created was not very attractive. The site’s HTML

Figure 6: Selecting tools as part of designing the ArcIMS web site.
and JavaScript files were manually edited using a text editor in order to customize the appearance of the site. To make it more visually pleasing, the site’s colors were changed from gray with black text to blue with gold text in order to match Tahoma.

![Toolbar Description](image)

**Figure 7**: The toolbar portion of the help page. This describes the tool symbols and how to use them (O’Dea 2002).
High School’s school colors. The default tool buttons displayed in the default site were small images that were not very intuitive to the novice user, so a help page containing descriptions of each tool’s function was created, as well as a general description of how to use the atlas (Figure 7). A series of hyperlinks to this and other HTML pages were added to the main ArcIMS site, including an “Information” page with a summary description of the atlas. A hyperlink to a “Disclaimer” page was also added, which states the following:

The owners of the Tahoma Virtual Atlas are not responsible for the quality, accuracy, or completeness of the data that is displayed within it. The data was compiled from multiple sources and is displayed here for educational purposes only. The owners of the Tahoma Virtual Atlas are NOT data distributors. To contact the creators/owners of the data, please refer to the metadata (O’Dea 2002).

Lastly, there is a “Metadata” hyperlink that opens an index page describing metadata and listing hyperlinks to available metadata for the layers that are displayed in the atlas (Figure 8). Due to time constraints, the quality of the metadata could not be formatted to match each other, and until that is possible the metadata displayed is just a brief description of the data, with links to the actual metadata collected from the data’s source if available.
The final step in the creation process was to write user guides that would be useful for the people at the high school taking over the maintenance of the atlas once it was completed. The first was the *Comprehensive ArcIMS 3.1 Installation*.
Guide (Appendix B), providing detailed instructions for installing all of the programs necessary to get ArcIMS working properly. The second was the ArcIMS 3.1 Site Management Guide (Appendix C), offering tips to accompany ESRI’s Using ArcIMS book that came with the software that would be useful for the teachers taking over the management of the atlas.

3.1.4. Implementation

Once completed, the Tahoma Virtual Atlas was introduced to the teachers. A demonstration was given, followed by a short lesson for teachers to do as an opportunity to become familiar with the atlas. While there were some frustrations with things such as site speed, occasional technical glitches, and some tool functions, the overall response was very positive. Those who had used ArcView before stated that the atlas was much easier to use and understand, and “more fun to play around with.” Three days after the training, one teacher was already using the atlas in his classes. During the training, use of the atlas began with some frustration and impatience on the teachers’ part, which decreased as they became more comfortable with the site. After the meeting, the teachers were given a survey inquiring about their impressions of the atlas as a tool for their classrooms (Appendix D). When asked to predict how their students will react to the Tahoma Virtual Atlas, one teacher responded, “They will be impatient and bored at first,
until they understand how powerful it is.” The teachers were excited to be able to access local data so easily, and to have control of what layers were displayed as well as the area itself to study. The supplemental help and metadata pages were important in providing answers for questions about how to use the atlas and information behind the data sets themselves.

Once ArcIMS is acquired and installed at Tahoma High School, the Tahoma Virtual Atlas will be transferred there from its initial location at Oregon State University in order to pass on responsibility and management. The GIS data sets and the ArcIMS files for the atlas will be copied onto CDs and installed at Tahoma High School by the author. The teacher responsible for the GIS at the high school will be trained in how to maintain the ArcIMS site and how it can be expanded to include additional data sets if they so desire. Once the Tahoma Virtual Atlas is completed, the Tahoma School District will take over the responsibility for the site.

3.2. THE FINAL PRODUCT

The final product consists of one main web page where all of the GIS functions and information can be easily accessed (Figure 9; O’Dea 2002: http://davyjones-dell-rogue.geo.orst.edu/website/Tahoma/viewer.htm). Students can select which layers they wish to display, zoom in to an area that they wish to
investigate, view the data table belonging to selected features, query for specific features, and perform simple data analysis. From the main page the viewer can access metadata for many of the layers in the atlas in order to view information about the data source, age, and definitions of table abbreviations. Users can also access the help page when they run into difficulties.

Figure 9: Opening view of the Tahoma Virtual Atlas (O’Dea 2002).
With the final product, teachers will be able to use the atlas to enhance their science lessons by combining inquiry-based learning with spatial data pertaining to their local community. Using the atlas to investigate a study site before and after field trips can enhance students’ experiences and increase their retention of information. In exploring the local physical geography, the Tahoma Virtual Atlas will be incorporated into a variety of potential lesson plans that will integrate scientific studies with technology, as well as connect youth with their community (Alibrandi 1998). For example, in lessons about water quality where students collect data from various points along a river, those points and their corresponding data can be created as a layer, added to the atlas, and analyzed by comparing the data to other layers such as land use, vegetation, or geology in order to develop hypotheses and conclusions. More importantly, a temporal database can be created that records results at the same locations over time, thus leading to more powerful analysis as well as giving students a sense of ownership and pride that they are doing important work. Students can learn about local plate tectonics by analyzing layers such as earthquake points and fault lines, and use the buffer tool on a selected fault or earthquake site to study potential impacts on their community. Using existing animal siting information from Washington’s Nature Mapping Program (University of Washington), animal habitats can also be studied by comparing species location with types of vegetation or terrain. Other intended uses include watershed studies, mapping local affects of global warming, and local geology.
In the future, students and teachers will be able to build onto the base atlas by adding their own layers via various methods: acquisition of already existing data (GIS layers, tables, or images), creation of their own field-collected data using Global Positioning System receivers, digitizing from paper maps, or scanning and georeferencing aerial photos. The atlas can also eventually be expanded to include other subjects such as history or social studies. To add any of these types of data, the use of ArcView is required as well as someone knowledgeable of the program in order to make it compatible with ArcIMS. This provides a perfect opportunity for more ambitious teachers and students who wish to delve deeper into the world of GISs. Unfortunately the atlas cannot be used as a data library due to permission issues of data owners, stating that we only had permission to view the data as well as provide information in how to contact the data owners should anyone wish to obtain their own copies. The data, however, can be shared within the district’s schools. One benefit of ArcIMS lies in the fact that if teachers find the ArcIMS site’s functionality to be too limiting, the same data sets can be accessed using ArcView.
4. OBSERVATIONS

There were some challenges encountered in creating the Tahoma Virtual Atlas using ArcIMS. Among the most difficult were the complexities of installing the program and the required components on the server, and getting the different components to communicate with each other. Supplementary software had to be acquired from multiple sources, and because there was minimal technical support available at the time of installation, the learning process required a significant amount of time for someone without a technical computer background. The installations themselves also required a lot of troubleshooting and further research as problems arose. As a result, a comprehensive ArcIMS installation guide was created, which was compiled from multiple sources into a single document leading through all software installations (Appendix B).

Once everything was installed and running properly, the site creation process went smoothly. The ArcIMS interface was easy to follow and user-friendly, even for someone without a lot of GIS experience. It allowed for the opportunity to make the site as simple or complex as desired by being able to select which tools to provide the user with on the site, as well as select which fields in the data tables would appear to the viewer when querying.

Since the time that the ArcIMS site was created and published on the Internet, there have been incidents where certain frames within the atlas web page
do not load correctly, stating either an error or appearing empty. Selecting the Refresh Map button at the bottom of the Layers menu, closing the web browser on the viewer’s computer and reopening it, or rebooting the computer if that fails (initially the user’s computer, or the ArcIMS server if that does not work) can usually resolve this problem. Another challenge came with the customization of the site. This also took technical knowledge, requiring some HTML and JavaScript programming. An HTML customization document produced by ESRI (ESRI 2000) made this process easier but was still challenging and time consuming for a novice computer programming person. Speed was also an issue, both of the computer and its Internet connection when accessing the atlas. Slow access to the site will probably somewhat hinder the success of the atlas when combined with short attention spans of students. During the teacher training in the high school’s high-quality computer lab, however, the response time was equally as fast as when accessing the atlas on the server itself.

Data compilation was also a time consuming and complex process due to the numerous data sources used and the large area covered. There were many factors to take into consideration when collecting data, such as scale of the data and its area of coverage. In some cases compromises needed to be made, such as selecting a lower resolution data set covering the whole display area over a higher resolution data set covering only a small area. Converting projections for some layers was challenging, and some data could not be used because the metadata provided the wrong projection information for the matching data set. Metadata also
needed to be considered in the compilation process, both in collecting it and editing it when modifications were made to the data sets. Overall, compilation would have been somewhat easier if a smaller area with a single delineation had been used for the coverage area, such as a single county or a watershed.

Data acquisition for the area covered by the Tahoma Virtual Atlas was challenging at times, but a wide variety of free data sets were available. For an experienced GIS user it was challenging to process and compile the necessary data sets, and it is easy to imagine the frustration that a teacher new to GIS would have in taking on a project like this themselves. Getting permission from data owners to display their data was not as difficult as expected, as long as it was guaranteed that the GIS data sets themselves were not downloadable and were just used for viewing and data analysis.

This project was developed with the intention of creating an atlas that could be turned over to the high school to manage once it was completed. Because of the challenges encountered in the ArcIMS implementation, it may be more of a challenge for the schools to maintain than originally thought. If others wish to create a similar project for school use, it is recommended to consider acquiring a host organization (perhaps city or county government, or nonprofit organization) that has the GIS and computer support to develop and maintain an ArcIMS site. While the science teachers at Tahoma High School wish to eventually add their own layers to the Tahoma Virtual Atlas, this could still be done through a host organization.
5. CONCLUSIONS

5.1. VIABILITY OF WEB GIS IN EDUCATION

5.1.1. Web GIS in Education

While some teachers have found desktop GIS programs and lessons to be useful in learning and teaching about GISs and geographic concepts, web GISs provide a new and potentially easier opportunity for incorporating GISs in education. Until now teachers wanting to use a GIS in lessons have had to devote much class time to teaching the technology (Audet and Paris 1997). While the fundamental educational objectives remain relatively consistent over time, the reality is that educational needs are constantly changing as well as the technology to support them (Mackaness 1994). That is why it is important to focus on the needs of the students in order to meet educational standards, and find ways to expose students to new technologies while supporting those fundamental objectives.

Web GISs have the potential for addressing time issues for educators. The simple interface and pre-collected data of a web GIS site require less training for teachers to learn to use, as well as less expertise for them to teach in their
classrooms. It also requires less time to present lessons to students in the classroom, therefore taking less time away from teaching a core curriculum. As a result of the simpler interface combined with less training time, more teachers may be likely to adopt the technology into their teaching, provided they have the computer resources to do so. With the fast-growing pool of diverse web GIS sites being created, educational GIS lessons can be easily expanded to incorporate a variety of themes from different sources.

A web GIS also addresses some of the issues regarding resources. Less software is required on the computers that students use because a web GIS simply requires a web browser and Internet to access the functionality. Computers still need to be powerful enough to effectively handle processing time, but do not require the necessary space to store GIS software and data sets. Facilities used for teaching with a GIS can be more flexible, because lessons aren’t restricted to computers that have GIS software and data installed. GIS functionality can even be accessed from students’ homes if they have Internet-accessible computers. Funding could also potentially be less, particularly if teachers use web GIS sites that have been created by other organizations. Currently ArcIMS offers limited capability compared to ArcView, but for some who just wish to use a GIS as an educational tool and not devote precious time to learning the technology of a GIS, the benefits of an easily accessible local atlas with a simple interface is more appealing.
The coupling of GISs and the Internet not only provides easier access to GIS technology in exploring the study area, but students can use the Internet to further explore other web sites related to the subject and area being studied (e.g., information about the area, a specific species, or certain geographic concepts). The web also provides a way for students to share their analyses and results, as well as collaborate with others anywhere else in the world (Mackaness 1994).

5.1.2. Community Mapping

Experience has shown that what excites students the most is information about their own community. The reality of local geography is the key to motivation, generating more enthusiasm and helping to teach “sense of place” geography (Merrick 2001, Thompson and Buttenfield 1997). Learning about the students’ own geographic area to meet educational standards helps to ingrain concepts (Napp and Smith 2001). When using local data, teachers can combine a GIS with field trips to offer a fresh perspective and increase students’ understanding of various interactions within their community and then use those conclusions to better understand broader global issues (Thompson and Buttenfield 1997). Students can also collect their own data through fieldwork and add them to the GIS, therefore giving them a sense of pride and ownership in their work.
An integral part of science education is hands-on learning. To best teach children about the physical environment around them, it is important to get the students outdoors and experiencing nature (Dvornich 2001). A person’s perspective is impacted when they have an opportunity to experience an area in person, and then be able to relate the three-dimensional world with the two-dimensional view that a GIS provides (Hagevik and Owens 2001). Physical geography is an important key in environmental education. The students need to think about the interactions between the many different aspects of the environment, such as the earth, atmosphere, geology, water and plants. Combining this hands-on education with a GIS as a tool to enhance the curriculum is a great way to get the students to think about how these things relate to each other not only on a small, local scale but on a larger scale as well (Dvornich 2001). The active learning that comes with using a GIS can help students to become more sensitive to community issues, such as environmental impacts, rather than passive reading or hearing about occurrences (Thompson and Buttenfield 1997).

A web GIS can be beneficial for community mapping. The most important benefit lies in the easy access of local data that resides on a web GIS site. Because local data are often acquired from different sources, it is more challenging for novice GIS users to collect and compile local data sets successfully. With a web GIS site created using local data, this challenge is not an issue because someone has already done the work. It also can provide a tie between schools and their community by sharing GIS services via the Internet. New possibilities are opened
up for sharing services with community organizations, as well as connecting educators by sharing tools, experiences, and curriculum using shared community web GIS sites.

5.1.3. Challenges and Benefits

In creating the Tahoma Virtual Atlas it was evident that, as with other GIS programs, a web GIS such as ArcIMS does not provide a solution to every teacher’s GIS woes. Drawbacks include various glitches that come with the territory of new software development, such as errors encountered by viewers when accessing the site. Software installation, maintenance, and site customization were the greatest challenges, particularly with minimal technical support. The time that it can take to access a web GIS site is also a drawback, particularly when dealing with the short attention span of students. These should become lesser issues as technology and Internet connections improve over time. Success also depends on the interest of teachers and their attitudes about the technology. There will most likely continue to be teachers who will not incorporate a GIS into their lessons, no matter how simple it is to use. For schools that develop their own web GIS, the initial expense of the software, site license, and data acquisition can also be a factor of success.
A web GIS can be the appropriate solution for some teachers, however, particularly if an existing web GIS site fits their needs or there is a GIS professional that can help with its development. It can help to increase GIS use in secondary education by providing a GIS resource that requires little training or expertise for teachers to learn and use in classes. In studying the development of the Tahoma Virtual Atlas, a number of benefits can be seen. By being online, the Tahoma Virtual Atlas is accessible from almost any computer with an Internet connection and not limited to only computers loaded with GIS software and data sets. Secondly, the ArcIMS web site offers basic GIS functionality in one interface, therefore simplifying the GIS as a tool and making it easier for teachers to center more on the subject that they are teaching and less on training students in how to use the GIS. This allows teachers more time to focus on teaching material that meets educational standards. Thirdly, the web GIS interface is perfectly suited towards student exploration of their community. Lessons can be created that lead students through step-by-step instructions, or allow them to explore information on their own. Additionally, more teachers will be able to incorporate the atlas into their courses because less training is needed to comfortably use the ArcIMS web site than is needed with a full GIS such as ArcView. Those who find ArcIMS too limiting in its GIS capabilities can use ArcView for more in-depth analysis using the same data sets that are displayed in the atlas. Finally, the atlas can be continually expanded by further collection of already existing data sets or student-created data sets collected from hands-on fieldwork. In addition, the atlas can be
expanded to other subjects such as history or social studies. When combined with curriculum and hands-on fieldwork, this web GIS atlas will provide a unique opportunity for students to learn about the complex interrelationships within their own community from a new perspective.

5.2. RECOMMENDATIONS

In order to successfully create and integrate a web GIS and community mapping into secondary science education, several things are necessary:

- Appropriate hardware, software, and Internet connections.
- Source of funds for hardware, software, site license, and data (for suggestions of some potential data sources, see Appendix E).
- Time, patience, and GIS knowledge (particularly ArcView) for acquiring and compiling data from various sources.
- A small or easily delineated area (e.g., watershed or single county) to improve ease of data collection.
- Technical support to assist in software installation and web server maintenance.
- A GIS professional in the community to assist in site creation, data issues, and curriculum development.
• Basic knowledge of GIS and geographic concepts, including spatial analysis.
• Curricula involving community studies that the site can complement.
• Site development beyond the web GIS that enhances the learning process, such as a help page, links to metadata, and lessons.

5.3. FUTURE WORK

Due to the time constraints of the project, only some of the implementation strategies for success could be addressed. Further study is needed in the development of curriculum that involves using the atlas, for which the science teachers will be responsible for creating. Because the atlas could not be implemented in the classrooms prior to the completion of this thesis due to lack of time, there also needs to be a follow-up study that measures the success of web GIS implementation based on opinions of teachers and students after the atlas has been used in the classroom. Factors to assess include the stability of the software (particularly when accessed by several computers at once), processing speed, and how the atlas is incorporated into the curriculum. Designing simplified metadata for data sets that are easier for students to interpret may also be important, for the Tahoma Virtual Atlas as well as GIS data used in schools in general. As one
teacher noted, however, the ability of students to be able to sift important facts from large amounts of information is one skill required by educational standards.

The future of the Tahoma Virtual Atlas depends on the maintained interest of the teachers it was designed for and their creativity in how it can be used and expanded. It can be expanded to include new data sets created by students or other subjects. Using ArcIMS, it is also possible to create other atlas pages based around specific themes or for different lessons. Teachers can create a site for studying water quality and watershed health, as well as another site for studying local geology and earthquakes. This will make each atlas page simpler by providing fewer layers to display, thereby better matching the theme of the new site.

While a web GIS such as ArcIMS offers a somewhat simpler way of incorporating a GIS into the classroom, there is still inevitably much room for improvement in its technology. Based on the increasing popularity of web GISs among GIS professionals as well as the public, combined with ever-improving technology, it is hoped that web GISs will become easier to develop and incorporate into secondary education, thus increasing their prevalence as pedagogic tools.
REFERENCES


Center for Image Processing In Education. <http://www.evisual.org> (May 2002)


Appendix A: Sample Form of Information Collected for Each Data Set
Compiled for the Tahoma Virtual Atlas

Layer Name: precip.shp
Definition: Annual average precipitation for King and Pierce Counties, 1961-90

Final data information:
- Format: shapefile
- Feature type: polygon
- Projection: State Plane, WA North, NAD 83 HARN, feet
- Metadata: precip.html
- Update? When new data comes out

Original data information:
- Name: wa_ann.e00
- How acquired: free Internet download
- Format: ArcInfo compressed coverage
- Feature type: polygon
- Scale: 1:250,000
- Projection: Geographic, decimal degrees, GRS80
- Date created: April 1998
- Metadata: wa_vect_meta.html
- Source organization: PRISM
- Web site: http://www.ocs.orst.edu/prism/state_products/wa_maps.html
Appendix B: Comprehensive ArcIMS 3.1 Installation Guide

This user’s guide describes the steps taken to install ArcIMS 3.1 and other required system software on a Windows 2000 Professional platform, using Apache Web Server. The procedures were compiled from Article 19714: Install Apache with Tomcat and ArcIMS 3.1 on Windows (ESRI 2000b), Minimal Apache-Tomcat Implementation for ArcIMS (Schultz 2002), and personal experience. It is a minimal installation guide and does not address issues of customization or security.

All programs except ArcIMS 3.1 are available via free Internet downloads (their locations are designated in the instructions). The following are the programs needed, in order of installation. Please see the bibliography at the end of this document for more information on these programs:

- JAVA™ 2 SDK 1.2.2 (contains Java Runtime Environment)
- Apache Web Server 1.3.23
- Apache’s Jakarta Tomcat 3.2.3
- Apache Module JServer
- ArcIMS 3.1 (from CD)
- JAVA™ 2 SDK 1.3.0_02 (from CD)

Notes:

- If the server’s C: drive is small (2GB), it is recommended that the C: drive either be expanded or all of the files be installed on a separate drive.

- Some programs can only be installed in directories that contain no spaces. As a result a Programs directory was created for those installations.

- If an old version of ArcIMS is already installed on the system, it should be removed as described in the ArcIMS installation guide.

- If old versions of Apache, Tomcat, or Java Servlet Development Kit 2.0 are already installed on the system, they should also be removed (see ESRI Article 19714).

- You must be logged in as Administrator to the system for installing and running ArcIMS.
1. Install JAVA™ 2 SDK, Standard Edition 1.2.2

In these instructions two versions of J2SDK are installed: version 1.2.2 and version 1.3.0_02. Version 1.2.2 contains the version of Java Runtime Environment (JRE) that correctly works with ArcIMS. The JDK 1.2.2 is used because of problems caused by JDK 1.3. These impact Java applications being run as Windows NT services and cause the Tomcat service to stop running when a user logs out (Schultz 2002). Version 1.3.0_02 is also required by ArcIMS, and will be installed later.


b. Install as per instructions on the web site.
   
   Directory Example: C:\Programs\jdk1.2.2

2. Install Jakarta Tomcat

a. Download Jakarta Tomcat 3.2.3 (jakarta-tomcat-3.2.3.zip) from http://jakarta.apache.org/builds/jakarta-tomcat/release/v3.2.3/bin/.

b. Create “Apache-Group” folder in the Programs directory, making sure that there are no spaces in the pathname.

c. Extract jakarta-tomcat-3.2.3.zip into the Apache-Group folder. The Jakarta Tomcat folder will be created within it.
   
   Directory Example: C:\Programs\Apache-Group\Jakarta-tomcat-3.2.3\

3. Configure Tomcat files

a. Navigate to the tomcat home\conf directory.
   
   Directory Example: C:\Programs\Apache-Group\Jakarta-tomcat-3.2.3\conf

b. Create copies of workers.properties and wrapper.properties files and rename them as original_workers.properties and original_wrapper.properties.

   c. In a text editor, open workers.properties and edit the tomcat_home and java_home directories as needed. Save and close the file.
Edit examples:

workers.tomcat_home=c:\Programs\Apache-Group\jakarta-tomcat-3.2.3
workers.java_home=c:\Programs\jdk1.2.2

d. In a text editor, open wrapper.properties and edit the tomcat_home and java_home directories as needed. Save and close the file.

Edit examples:

wrapper.tomcat_home=c:\Programs\Apache-Group\jakarta-tomcat-3.2.3
wrapper.java_home=c:\Programs\jdk1.2.2

4. Set Environment System Variables

a. Open the Environmental Variables window by going to Start → Settings → Control Panel → System → Advanced tab → Environment Variables button.

b. Under “User Variables for Administrator”, add the variable JAVA_HOME and direct it to the path that contains Java Runtime Environment (JRE).
   Example: C:\Programs\jdk1.2.2

c. Under “User Variables for Administrator”, add the variable TOMCAT_HOME and direct it to the path that contains Jakarta Tomcat.
   Example: C:\Programs\Apache-Group\Jakarta-tomcat-3.2.3

5. Create Jakarta Tomcat NT Service


b. Open a command prompt window by going to Start → Programs → Command Prompt (may be different on some computers).

c. Change the working directory to Tomcat Home\conf.
   Example: cd Programs\Apache-Group\jakarta-tomcat-3.2.3\conf
d. Type the following command to create the Tomcat NT service:
   
   ```bash
   Jk_nt_service -I Tomcat wrapper.properties
   ```

e. To start Tomcat, type the following:
   
   ```bash
   Net start Tomcat
   ```

g. Check to see if the Tomcat service is running by going to Start ➔
   Settings ➔ Control Panel ➔ Administrative Tools ➔ Services. Stop
   the service if it is running by selecting Tomcat and selecting the Stop
   button.

f. Restart the service by selecting the Action drop-down menu and then
   Start. The startup type should be Automatic. If not, go to Action ➔
   Properties, select Automatic as the startup type, and click OK when
   done.

6. Install Apache 1.3.23

   a. Download Apache 1.3.23 (apache_1.3.23-win32-x86-no_src.exe) from

   b. Install the program by selecting the .exe file and following the
      instructions given.

c. At the Server Information screen enter the following:
   
   ```
   Network Domain: <domain name>  
   Example: geo.orst.edu  
   Server Name: <your computer name>  
   Example: davyjones-dell-rogue.geo.orst.edu  
   Administrator’s Email Address: <your address>
   ```
   Select “Run as a service for all users”, then Next.

d. Choose Complete Setup.

e. In the Destination Folder window select “Change to specify the install
   location…”

f. Install when prompted, finish the process and reboot the computer.

68

   g. Edit the httpd.conf file by going to Start ➔ Programs ➔ Apache httpd
      Server ➔ Configure Apache Server ➔ Edit the Apache httpd.conf
      Configuration File.
h. Find the following line:
   DirectoryIndex index.html

   Change it to read:
   DirectoryIndex index.html default.htm

i. At the bottom of the file add the following line:
   Include <tomcat drive>:\ jakarta-tomcat-3.2.3\conf\tomcat-
apache.conf-auto

   Example: Include C:\Programs\Apache-Group\jakarta-tomcat-
   3.2.3\conf\tomcat-apache.conf-auto

j. Verify that the installation was successful by opening a web browser
   and typing your computer name.
   Example: http://davyjones-dell-rogue.geo.orst.edu

   The page should read “Seeing this instead of the website you expected?”

   If the page isn’t running, go to Start ➔ Settings ➔ Control Panel ➔
   Administrative Tools ➔ Component Services and check that Apache is started.
   Turn it on if it is not. If this does not fix it, then you need to review the
   installation process.

7. Download Apache JServ Module

   a. Download mod_jk.dll file from http://jakarta.apache.org/builds/jakarta-
tomcat/release/v3.2.3/bin/win32/i386/.

   b. Save the file in Apache’s modules directory.
      Example: C:\Programs\Apache-Group\Apache\modules

   c. Verify its location after downloading.

8. Verify that everything works

   a. Reboot the computer.

   b. Check that Tomcat and Apache services started by opening a web
      browser and entering your computer’s name. Apache’s index page
      should appear.
c. Run tests by looking at Apache’s example pages in the browser window by typing “examples” after the computer’s name:

<host machine>/examples

d. Select Servlets and then Execute next to “Hello World”. If a page appears that says “Hello World!” then servlets are running correctly.

e. Navigate back to the Examples page, select jsp and then Execute next to Snoop. If you get a page titled “Request Information” and containing information about your computer, JSPs are running correctly, and Apache and Tomcat are running fine.

9. Install ArcIMS 3.1

For further installation information, refer to the ArcIMS 3.1 Installation Guide that accompanies the software as well as ESRI Article 19714 (ESRI 2002).

a. Run setup.exe from the installation CD.

b. View the Readme file if desired, and click Next.

c. Accept the license agreement, and click Next.

d. In the Installation Type window, select Typical Installation, and click Next.

e. In the Installation Directory window, navigate to the installation directory, and click Next.

Example: C:\ESRI\ArcIMS3.1

f. In the Java Runtime Environment Installation window, choose to install JRE 1.3.0_02 in the \JavaSoft\jre directory, and click Next. (Unsure if this is correct because I navigated to JRE 1.2.2 instead and ArcIMS didn’t work, so I had to reinstall Manager)

Example: C:\Programs\JavaSoft\jre\jre1.3.0_02

g. In the Host Name and Working Directories window, leave the default protocol as http, and change the default to the host name.

Example: davyjones-dell-rogue.geo.orst.edu
h. Set the web site working directory to where you want the web sites stored. If you accept the default, then you will need to create Website and Output directories as instructed on p. 49 of the installation guide once the installation is complete.
   \textit{Example:} F:\WorkSpace\ArcIMS

i. Set the User’s Working Directory within that workspace, in the ArcIMS directory. Then click Next.
   \textit{Example:} F:\WorkSpace\ArcIMS\AXL

j. In the Application Server Information Window, change the host name to your computer’s name.
   \textit{Example:} davyjones-dell-rogue.geo.orst.edu

k. Leave the defaults for the Registry Port and the Connector Port (or change them if necessary). Click Next.

l. In the Servlet Connector Directory window, navigate to the location of your Servlet directory.
   \textit{Example:} C:\Programs\Apache-Group\jakarta-tomcat-3.2.3\conf\tomcat-apache.conf-auto

m. In the Windows Services Authorization window, change the user name if necessary and enter the password twice to confirm it. This username and password need to be the computer profile account that is utilized to install and run ArcIMS (it must have Administrator privileges). ArcIMS requires this information in order to run some of its services. Click Next.
   \textit{Example:} Domain\User Name: ROGUE-GEO\Administrator

n. In the Summary of Installation Information window, confirm that all the information displayed is correct; if it’s not, go back and change what is needed. Click Next to install.

o. You may be prompted to update Microsoft’s Java VM if 3186 is not found on the system (This is located in JRE).

p. In the Installation Successful screen, click Finish and reboot your computer.

q. After the computer reboots, the next step is to update the Services file. Open up a text editor such as Notepad, and then open the Services file which is typically located in C:/WINNT/System32/drivers/etc/. Add the
following Port Numbers, placing them in the correct numerical order among the other files:

- esri_conn 5300/tcp #ARCIMS connector port
- esri_reg 5353/tcp #ARCIMS registry port

r. Save the file when done and close the text editor.

10. Configure Tomcat to Work with ArcIMS

   a. Look in the <tomcat home>/webapps/ROOT/WEB-INF/classes folder and confirm that the following files are there:

      Example: C:\Programs\Apache-Group\jakarta-tomcat-3.2.3\webapps\ROOT\WEB-INF\classes

      com directory
      Esrimap_prop
      jaxp.jar
      parser.jar
      ServletConnector_Res.properties
      ServletConnector_Res_en_US.properties
      WMSEsrimap_prop

      If the files are not there, stop the Apache Web Server by going to Start ➔ Settings ➔ Control Panel ➔ Administrative Tools ➔ Component Services and then stopping the service.

      Then copy the missing files from <ArcIMS Installation directory>/Connectors/Servlet into the folder listed in Step a.

   b. Stop both the Tomcat and Apache services that are running. To do so go to Start ➔ Settings ➔ Control Panel ➔ Administrative Tools ➔ Component Services.

   c. In a text editor, open <tomcat home>/conf/wrapper.properties. Search for “wrapper.class_path”.

      In the list, add the following and save the file when done:

      wrapper.class_path=$(wrapper.tomcat_home)/webapps/ROOT/WEB-INF/classes/jaxp.jar
      wrapper.class_path=$(wrapper.tomcat_home)/webapps/ROOT/WEB-INF/classes/parser.jar
11. Test ArcIMS installation with diagnostics tool

a. To run the diagnostics tool, go to Start ➔ Programs ➔ Esri ➔ ArcIMS 3.1 ➔ ArcIMS Diagnostics. If you have a browser that requires the user to sign in (such as some versions of Netscape). You may get an error in ArcIMS. Ignore the error command that appears telling you that the file cannot be found, find the browser’s login window (sometimes hidden by other open windows) and log in. The diagnostics page should appear in the web browser.

b. The default web server name and port number should appear on the Web page.

c. Click the test buttons to check each of the configurations. If either of the tests reports an error, you can read about the error from the “Select Error” menu. If you have trouble fixing the problem based on these instructions, go the ESRI Support Center Advanced Search site at: 

If you get Error 6, the passwords for ArcIMS Application Server, Monitor, and Tasker may need to be changed. They must match the Windows 2000’s Administrator password. To do this, go to Start ➔ Settings ➔ Control Panel ➔ Administrative Tools ➔ Component Services, select the service, go to Action ➔ Properties, and select the Log On tab. Start the services when finished.

d. If you did not set up the website working directories in step 9h, go to “Creating Virtual Directories” on page 49 of the ArcIMS 3.1 Installation Guide.

12. ArcIMS Configuration

For the final steps, refer to “Configuring ArcIMS” on page 67 of the ArcIMS 3.1 Installation Guide.

a. Increasing memory parameters for Java VM:
   1. Go to Start ➔ Programs ➔ Java Plug-in Control Panel.
2. Under the Basic tab, set the required memory parameters to
the numbers used in the ESRI example:
   Example: javaw.exe  –Xms10m  –Xmx256m
3. Click on Apply and close the window.

b. Set your Windows 2000 PATH variable:
   1. Go to Start  ⇒  Settings  ⇒  Control Panel  ⇒  System.
   2. Under the Advanced tab, open Environment variables.
   3. In System Variables, select PATH.
   4. Click on Edit and add the JRE location at the end.
      Example: C:\Programs\JavaSoft\JRE\1.3.0_02
   5. Click OK and close the window.

c. I did not do anything about a proxy server.

You are now ready to begin using ArcIMS.

*Note:* The first time I opened ArcIMS Manager, it prompted me to set the site
administrator user name. It is important to pick a name and password that are easy
to remember and can be given to other people who will also be creating site using
ArcIMS on that computer.

**Bibliography**


____. 2000b. Article 19714: Install Apache with Tomcat and ArcIMS 3.1 on
(February 2002)

tomcat/tomcat-3.2-doc/tomcat-apache-howto.html> (February 2002)

jdk/1.2.2/> (February 2002)

Wisconsin Dept. of Commerce. <http://comgis1.commerce.state.wi.us/
main/assist/arcims_apache_tomcat_setup_2002_01_09.htm> (April 2002)


Appendix C: ArcIMS 3.1 Site Management Guide

ArcIMS 3.1 Site Management Guide
For the Tahoma Virtual Atlas

Created for the Tahoma School District
June 2002

By
Liz O’Dea

Table of Contents

Overview ....................................................................................... 77
Data ............................................................................................... 77
  Requirements ........................................................................... 77
  Limitations .......................................................................... 78
  File Structure ...................................................................... 78
  Factors to Consider When Acquiring Data ...................... 79
  Data Conversions ................................................................ 79
  What About Images? .......................................................... 80
  Metadata ............................................................................. 81
ArcIMS ..................................................................................... 81
  Management ........................................................................ 81
  Adding, Changing a Layer .............................................. 81
  Technical Problems and How to Resolve Them ............. 81
Overview

This site management guide has been created for the Tahoma School District to accompany The Tahoma Virtual Atlas, an online physical geographic community atlas. It is intended for the teacher(s) who will manage the atlas after it has been handed over to the school district upon completion. Basic management issues are covered, such as what data can be added to the atlas, what format that data needs to be in, how to add new layers to the atlas, and how to solve potential technical problems.

The Tahoma Virtual Atlas was created using the Environmental Systems Research Institute’s (ESRI) Arc Internet Map Server (ArcIMS) software, with the help of ArcView 3.2 and ArcGIS 8.1 in compiling the data. When discussing instructions for managing the atlas, this guide discusses how to do it using ArcView 3.2 (for data editing and creation) and ArcIMS 3.1 (for editing the atlas’s data display) on the computer server where the atlas and its data are stored.

What is ArcIMS? ArcIMS is a computer program that brings basic GIS functionality to the Internet via a simple online interface, without the need for GIS software or data on the user’s computer. With The Tahoma Virtual Atlas, students can access base and physical geographic data for Pierce and King Counties. Students can zoom into areas of interest, turn layers on and off, query data sets, and even buffer features such as streams.

For a more detailed description of ArcIMS and how to use it, please refer to Using ArcIMS, which is the guide that accompanies the ArcIMS software.

Data

Requirements

GIS data displayed the atlas need to be in ArcView shapefile format.

Data need to be in the following projection:

- State Plane, Washington North Zone
- NAD 83 HARN
- Lambert Conformal Conic
- Units: Feet
Limitations

Permission has been given by data owners to DISPLAY ONLY the data that they provided. Data sets can be used by teachers and students for school-related projects, but the data can in no way be distributed outside of the Tahoma School District. If anyone wishes to acquire copies of the data sets, they need to contact the organization that owns the original data. Some data is freely downloadable from the internet, and some must be ordered from the organizations. If a data set has accompanying metadata, the contact information can usually be located there.

File Structure

Data sets are stored in the following directories:

- **Tahoma/data/**
  - boundaries/
  - climate/
  - DEMs/
  - doqs/
  - geology/
  - hydrology/
  - kingco/
  - landcover/
  - landuse/
  - other/
  - pierceco/
  - reference/
  - roads/
  - state/

Metadata are stored in:

- **Tahoma/data/metadata/**

The following are where the main ArcIMS files are stored:

- **ArcIMS/AXL/tahoma.axl**
- **ArcIMS/Website/tahoma/*.html and .js files**

The supplemental information pages created for the atlas are stored here:

- **ArcIMS/Website/tahoma/infopages/**
Factors to Consider When Acquiring Data

- Does it have metadata?
- What is its projection?
- At what scale data was created? Is the resolution adequate? (1:24000 is considered detailed; 1:250000 is not.)
- How reliable is the data source?
- How detailed is the data? Is there good information in the data tables?
- If it is an image, does it come with a “world file”? (see below)
- Is it a grid? If so, you need to convert it to an image or polygon file.

Data Conversions

GIS data can come in various formats. The following instructions show how to convert some of the most common GIS data formats into ArcView shapefiles using ArcView 3.2.

Reprojecting Data in ArcView

Reprojecting data can be tricky. Converting between different projections in different datums (NAD 27 and NAD 83) sometimes requires a couple of different conversions (first convert the datum, then convert the projection) in order to accurately reproject a data set. For more information, please refer to the ArcView Help. The following are generic instructions on how to use the Projection Wizard to reproject a data set to the projection used in the Tahoma Virtual Atlas.

1. Turn on the Projection Utility Wizard extension in File ➔ Extensions.
2. Open the ArcView Projection Utility by going to File ➔ ArcView Projection Utility.
3. In Step 1, select the Browse button and navigate to the file(s) you wish to reproject.
4. In Step 2, the utility displays the current coordinate system. Accept the defaults by clicking the Next button.
5. In Step 3, select the new coordinate system. Under the Name tab select Projected as the Coordinate System Type, NAD_83_Washington_North as the Name, and Feet as the Units. If you need to change datums, choose a transformation under the Datum tab.
6. In Step 4, Click the Browse button and navigate to where you want to store the shapefile, and give it a new name ending in “.shp”.
7. Next, verify the settings and select the Finish button.
ArcInfo Interchange File (.e00) to ArcInfo Coverage

1. From the computer’s Start menu, go to Programs → ESRI → ArcView 3.2 → Import 71.
2. In the window that appears, click on the Browse button to select the export filename that you wish to import. Then click on the Browse button and select the directory where you wish to store the new file. Remember to give the output file a new name.
3. Click on OK, and the new coverage is created.

ArcInfo Coverage to ArcView Shapefile

1. In ArcView, open a new View window.
2. Add the ArcInfo coverage to the view, and turn the layer on.
3. Make sure that the coverage is active by selecting the name in the legend.
4. Under the Theme pull-down menu, select Convert to Shapefile...
5. Navigate to the directory you wish to store the shapefile, and give it a name ending in “.shp”, then select OK.
6. Select OK when it the window prompts you to add the new shapefile to the view. The new shapefile has been created.
7. Make sure that the data table contains the same information as the coverage.

What About Images?

Images can be displayed in ArcIMS. In order to do this, an image needs to be spatially referenced so that it lines up properly with the other layers. The first thing that is required of the image is that it has an accompanying world file. This world file is a text file that contains the coordinates of the image’s corners, usually in decimal degrees (a decimal format of latitude/longitude coordinates). The file extension usually consists of two letters of the image type followed by a “w”. For example, a .jpg image’s world file has the extension .jgw.

Some image files are more complex, and are assigned a projection such as a USGS digital orthoquad (DOQ). There is currently no easy way to reproject an image, and if you cannot get an image to draw correctly and need it to be at a specific projection, contact the organization supplying the image to see if they can put the image in the appropriate projection for you.
Metadata

Metadata is a vital component of the atlas. It supplies important information about each data set such as who created it and owns it, how old the data is, what scale the data was created at, and what information in the data table means. The quality of metadata varies greatly between sources, and if acquiring new data sets it is important to also acquire its metadata.

In the atlas itself, there is a link to a metadata index page. If new layers are added to the atlas, it is important to add the metadata to this page. See the file structure above to see where the metadata is stored. The ArcIMS/Website/tahoma/infopages/meta_index.html file needs to be updated to display the link to the metadata itself.

ArcIMS

Management Tips

In order to work with ArcIMS, you must be logged in to the server as Administrator. ArcIMS can only be run using Internet Explorer, not Netscape. The ArcIMS login must be a name and password that others potentially working with ArcIMS will know. There are several components to ArcIMS (Author, Designer, Administrator) that focus on specific functions, such as editing the layers displayed in the atlas or the design of the atlas layout. ArcIMS Manager ties all of the components together in a wizard-type format, walking you through all of the steps to create or edit a site.

Adding, Changing a Layer

This can be done in Author or Manager. Please refer to the ArcIMS User Guide that accompanies the software to see the instructions on how to add or edit layers. You can set things such as symbol color, size, and other factors in how the layers are displayed.

Technical Problems and How to Resolve Them

There are some quirks with ArcIMS, both on the server itself and from the viewers accessing the atlas. Here are a few of the common ones:
- While editing the ArcIMS site on the server, ArcIMS sometimes freezes or crashes. Be sure to SAVE OFTEN! If it freezes, kill the program and try reopening ArcIMS. If that doesn’t work, reboot the computer.

- When accessing the atlas, viewers sometimes have trouble with loading all of the frames for the atlas on their computer. This problem can usually be corrected by closing the browser and reopening the atlas. If this doesn’t work, the computer should be rebooted. If this doesn’t work, the atlas administrator should try rebooting the server itself. Otherwise the problem can be due to numerous factors, including inadequate technology of the computer accessing the site.

- If other problems are encountered, there are some online resources available to search for a solution:

  - ESRI ArcIMS Online Support Center:

  - ESRI Advanced Search:
    http://support.esri.com/search/default.asp

  - ESRI User Forum (post a question):
    http://forums.esri.com/forums.asp?c=64
Appendix D: Tahoma High School Teacher Survey

Please take a few minutes to look at the Tahoma Virtual Atlas (http://davyjones-dell-rogue.geo.orst.edu/website/Tahoma/viewer.htm), and answer the following questions. E-mail your responses to gisliz@hotmail.com. Thank you!

1. What type of computer are you using (PC/Mac)? What operating system is running (Windows 98, NT, etc.)?

2. What Web browser are you using (Explorer/Netscape)?

3. Did you find the atlas easy or challenging to use? In what way(s)?

4. Did you access the help page? Was it helpful in using the site? Add any comments.

5. Did you have any technical difficulties while accessing the site? If so, please describe.

6. Please give a brief description of the lessons you teach that would benefit from the atlas.

7. How do you think your students would respond if having to use this site in class (interested, impatient, bored, excited,…)?

8. What do you like about the atlas?

9. What do you NOT like about the atlas?

12. Other comments and feedback:
Appendix E: Potential Local Base and Environmental Data Sources

For educators interested in acquiring local base and environmental data, there are several potential sources that are common for most places in the United States. This document lists only some of them, including sites relevant to Washington State. The best way to find out what datasets each organization have is to search the Internet; some data is freely downloadable, while others charge for downloading or ordering the data on CD.

**Online Data Clearinghouses**

GeoCommunity  
www.geocommunity.com

Geography Network  
www.geographynetwork.com

GIS Data Depot  
www.gisdatadepot.com

**Federal Agencies**

Bureau of Land Management  
Washington/Oregon:  
http://www.or.blm.gov/gis/

Environmental Protection Agency  
Region 10:  
http://www.epa.gov/r10earth/index.htm

National Park Service  
http://www.nps.gov/gis/

Natural Resource Conservation Service  
http://www.wa.nrcs.usda.gov/Tech_Resource/GIS/

National Soil Survey Center  
http://www.statlab.iastate.edu/soils/nssc/

National Wetlands Inventory  
http://www.nwi.fws.gov/
US Census Bureau
   http://www.census.gov/index.html

US Forest Service
   Regional Ecosystem Office (Northwest Region 6):
   http://www.reo.gov/reo/data/data.htm

US Geological Survey
   Digital Orthophoto Quadrangles:

   Earth Resources Observation Systems Data Center:
   http://edcwww.cr.usgs.gov/

   National Earthquake Information Center:
   http://neic.usgs.gov/

**State Agencies**

Department of Ecology
   http://www.ecy.wa.gov/services/gis/index.html

Department of Fish and Wildlife
   http://www.wa.gov/wdfw/home.htm

Department of Natural Resources
   http://www.wa.gov/dnr/

Department of Transportation
   http://www.wsdot.wa.gov/gis/GeoDataCatalog/default.htm#main

State GIS Center
   Washington Geographic Information Council:
   http://www.wa.gov/gic/washdat.htm

   Washington State Geospatial Clearinghouse:
   http://metadata.gis.washington.edu/
Other

County GIS Departments
   King County:
       http://www.metrokc.gov/gis/
   Pierce County:
       http://triton.co.pierce.wa.us/geodataexpress/main.html

Nonprofit Organizations
   The Community and Environment Spatial Analysis Center
      (CommEn Space):
       http://www.commenspace.org/index.html

University Libraries/Departments/Organizations:
   Climate Mapping with PRISM:
       http://www.ocs.orst.edu/prism/prism_new.html
   Pacific Northwest Seismograph Network:
       http://www.ess.washington.edu/SEIS/PNSN/
   Washington State Geospatial Data Archive (WAGDA):
       http://wagda.lib.washington.edu/data/washdata.html